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SUMMARY: 24 
We describe a behavioral protocol designed to assess how zebrafish’s personalities influence 25 
their response to water currents and weak magnetic fields. Fishes with the same personalities 26 
are separated based on their explorative behavior. Then, their rheotactic orientation behavior in 27 
a swimming tunnel with a low flow rate and under different magnetic conditions is observed. 28 
 29 
ABSTRACT: 30 
To orient themselves in their environment, animals integrate a wide array of external cues, which 31 
interact with several internal factors, such as personality. Here, we describe a behavioral protocol 32 
designed for the study of the influence of zebrafish personality on their orientation response to 33 
multiple external environmental cues, specifically water currents and magnetic fields. This 34 
protocol aims to understand whether proactive or reactive zebrafish display different rheotactic 35 
thresholds (i.e., the flow speed at which the fish start swimming upstream) when the surrounding 36 
magnetic field changes its direction. To identify zebrafish with the same personality, fish are 37 
introduced in the dark half of a tank connected with a narrow opening to a bright half. Only 38 
proactive fish explore the novel, bright environment. Reactive fish do not exit the dark half of the 39 
tank. A swimming tunnel with low flow rates is used to determine the rheotactic threshold. We 40 
describe two setups to control the magnetic field in the tunnel, in the range of the earth’s 41 
magnetic field intensity: one that controls the magnetic field along the flow direction (one 42 
dimension) and one that allows a three-axial control of the magnetic field. Fish are filmed while 43 
experiencing a stepwise increase of the flow speed in the tunnel under different magnetic fields. 44 
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Data on the orientation behavior are collected through a video-tracking procedure and applied 45 
to a logistic model to allow the determination of the rheotactic threshold. We report 46 
representative results collected from shoaling zebrafish. Specifically, these demonstrate that 47 
only reactive, prudent fish show variations of the rheotactic threshold when the magnetic field 48 
varies in its direction, while proactive fish do not respond to magnetic field changes. This 49 
methodology can be applied to the study of magnetic sensitivity and rheotactic behavior of many 50 
aquatic species, both displaying solitary or shoaling swimming strategies. 51 
 52 
INTRODUCTION:  53 
In the present study, we describe a lab-based behavioral protocol which has the scope of 54 
investigating the role of fish personality on the orientation response of shoaling fish to external 55 
orientation cues, such as water currents and magnetic fields. 56 
 57 
The orienting decisions of animals result from weighing various sensory information. The decision 58 
process is influenced by the ability of the animal to navigate (e.g., the capacity to select and keep 59 
a direction), its internal state (e.g., feeding or reproductive needs), its ability to move (e.g., 60 
locomotion biomechanics), and several additional external factors (e.g., time of day, interaction 61 
with conspecifics)1. 62 
 63 
The role of the internal state or animal personality in the orientation behavior is often poorly 64 
understood or not explored2. Additional challenges arise in the study of the orientation of social 65 
aquatic species, which often perform coordinated and polarized group movement behavior3. 66 
 67 
Water currents play a key role in the orientation process of fish. Fish orient to water currents 68 
through an unconditioned response called rheotaxis4, which can be positive (i.e., upstream 69 
oriented) or negative (i.e. downstream oriented) and is used for several activities, ranging from 70 
foraging to the minimization of energetic expenditure5,6. Moreover, a growing body of literature 71 
reports that many fish species use the geomagnetic field for orientation and navigation7–9.  72 
 73 
The study of rheotaxis and swimming performance in the fish is usually conducted in flow 74 
chambers (flume), where fish are exposed to the stepwise increase of the flow speed, from low 75 
to high speeds, often until exhaustion (called critical speed)10,11. On the other hand, previous 76 
studies investigated the role of the magnetic field in the orientation through the observation of 77 
the swimming behavior of the animals in arenas with still water12,13. Here, we describe a 78 
laboratory technique that allows researchers to study the behavior of fish while manipulating 79 
both the water currents and the magnetic field. This method was utilized for the first time on 80 
shoaling zebrafish (Danio rerio) in our previous study, leading to the conclusion that the 81 
manipulation of the surrounding magnetic field determines the rheotactic threshold (i.e., the 82 
minimal water speed at which shoaling fish orient upstream)14. This method is based on the use 83 
of a flume chamber with slow flows combined with a setup designed to control the magnetic field 84 
in the flume, within the range of the earth’s magnetic field intensity. 85 
  86 
The swimming tunnel utilized to observe the behavior of zebrafish is outlined in Figure 1. The 87 
tunnel (made of a nonreflecting acrylic cylinder with a 7 cm diameter and 15 cm in length) is 88 



  

connected to a setup for the control of the flow rate14. With this setup, the range of flow rates in 89 
the tunnel varies between 0 and 9 cm/s.  90 
 91 
To manipulate the magnetic field in the swimming tunnel, we use two methodological 92 
approaches: the first is one-dimensional and the second is three-dimensional. For any 93 
application, these methods manipulate the geomagnetic field to obtain specific magnetic 94 
conditions in a defined volume of water—thus, all the values of magnetic field intensity reported 95 
in this study include the geomagnetic field. 96 
 97 
Concerning the one-dimensional approach15, the magnetic field is manipulated along the water 98 
flow direction (defined as the x-axis) using a solenoid wrapped around the swimming tunnel. This 99 
is connected to a power unit, and it generates uniform static magnetic fields (Figure 2A). 100 
Similarly, in the case of the three-dimensional approach, the geomagnetic field in the volume 101 
containing the swimming tunnel is modified using coils of electric wires. However, to control the 102 
magnetic field in three dimensions, the coils have the design of three orthogonal Helmholtz pairs 103 
(Figure 2B). Each Helmholtz pair is composed of two circular coils oriented along the three 104 
orthogonal space directions (x, y, and z) and equipped with a three-axial magnetometer working 105 
in closed-loop conditions. The magnetometer works with field intensities comparable with the 106 
earth’s natural field, and it is located close to the geometrical center of the coils set (where the 107 
swimming tunnel is located).  108 
 109 
We implement the techniques described above to test the hypothesis that the personality traits 110 
of the fish composing a shoal influence the way they respond to magnetic fields16. We test the 111 
hypothesis that individuals with proactive and reactive personality17,18 respond differently when 112 
exposed to water flows and magnetic fields. To test this, we first sort zebrafish using an 113 
established methodology to assign and group individuals that are proactive or reactive17,19–21. 114 
Then, we evaluate the rheotactic behavior of zebrafish swimming in shoals composed of only 115 
reactive individuals or composed of only proactive individuals in the magnetic flume tank, which 116 
we present as sample data. 117 
 118 
The sorting method is based on the different tendency of the proactive and reactive individuals 119 
to explore novel environments21. Specifically, we use a tank divided into a bright and a dark 120 
side17,19–21 (Figure 3). Animals are acclimated to the dark side. When access to the bright side is 121 
open, proactive individuals tend to quickly exit the dark half of the tank to explore the new 122 
environment, while the reactive fish do not leave the dark tank.  123 
 124 
PROTOCOL: 125 
The following protocol has been approved by the Institutional Animal Care and Use Committee 126 
of the University of Naples Federico II, Naples, Italy (2015).  127 
 128 
1. Animal maintenance 129 
 130 
1.1. Use tanks of at least 200 L to host a shoal of at least 50 individuals of both sexes in each tank. 131 
 132 



  

NOTE: The density of the fish in the tank has to be one animal per 2 L or lower. Under these 133 
conditions, zebrafish will display normal shoaling behavior. 134 
 135 
1.2. Set the maintenance conditions as follow: temperature at 27–28 °C; conductivity at <500 μS; 136 
pH 6.5–7.5; NO3 at <0.25 mg/L; and a light:dark photoperiod at 10 h:14 h. 137 
 138 
NOTE: Identical holding conditions must be used for both the mixed population and the 139 
separated proactive and reactive populations.  140 
 141 
2. Personality selection in zebrafish 142 
 143 
2.1. Prepare and place the personality selection tank in a quiet room (Figure 3) with the same 144 
water as used in the maintenance tanks. 145 
 146 
2.2. Place a video camera above or at the side of the tank. Connect the camera to a computer 147 
with a monitor located in an area where there is no visual contact with the tank.  148 
 149 
NOTE: Try to limit the interactions with the tanks and fish to the least amount of time possible. 150 
Avoid noise and fast movements.  151 
 152 
2.3. Select nine fish at random from the maintenance tank and transfer them to the dark side of 153 
the personality selection tank, using a knotless net. 154 
 155 
NOTE: If necessary, transfer the animals in a small-volume transporting tank (about 2 L) with 156 
water from the holding tank. The fish must be fed ad libitum prior to the transfer to the 157 
experimental tank. This limits the possibility that different tendencies of food-seeking behavior 158 
would affect the behavior of the individuals during the following experiment22. Try to minimize 159 
the capture time, avoid collecting multiple fish as it might cause physical damage to the animals, 160 
and do not hold the fish for more than a few seconds in the net as these factors can increase 161 
stress. Conduct replicate experiments at the same time of the day. This minimizes variability in 162 
the behavior of the experimental groups caused by possible circadian rhythms23. 163 
 164 
2.4. After 1 h of acclimatization, open the sliding door. 165 
 166 
NOTE: Individuals who exit from the hole, exploring the bright side of the tank within 10 min, are 167 
considered proactive21. 168 
 169 
2.5. After 10 min, gently remove the proactive individuals from the tank and transfer them to the 170 
proactive maintenance tank. 171 
 172 
2.6. After 15 min, collect the fish that remain in the dark box, which are considered reactive21, 173 
and transfer them to the reactive maintenance tank. 174 
 175 
NOTE: Discard fish that move to the bright side of the tank after 10 min21. Perform the personality 176 



  

test with nine fish at a time until the desired number of proactive and reactive fish necessary for 177 
the tests described in section 5 are collected. Consistency of the proactive and reactive 178 
personality can be checked regularly using the same approach.  179 
 180 
3. Set up of the magnetic field with the one-dimensional magnetic field manipulation27 181 
 182 
3.1. Switch on the Power unit (Figure 2A). 183 

 184 
3.2. Place the coiled tunnel in the location where the rheotactic protocol will be performed 185 
(section 5) but keep it disconnected from the swimming apparatus (Figure 2A). Place a magnetic 186 
probe connected with a Gauss/Teslameter inside the tunnel and verify which voltage is necessary 187 
to obtain the chosen magnetic field value along the major axis of the tunnel. 188 
 189 
NOTE: Because of the magnetic properties of a solenoid, the field is reasonably uniform inside 190 
the tunnel; this can be checked by slowly moving the probe both horizontally and vertically. 191 

 192 
3.3. Disconnect the probe and connect the flow tunnel to the swimming apparatus. 193 

 194 
3.4. Start with the rheotactic protocol (section 5). 195 

 196 
4. Set up of the magnetic field with the three-dimensional magnetic field manipulation27 197 

 198 
4.1. Switch on the CPU, DAC, and coil drivers (Figure 2B). 199 

 200 
4.2. Set the chosen magnetic field on each one of the three axes (x, y, and z). 201 

 202 
4.3. Place the tunnel in the center of the Helmholtz pairs set. 203 

 204 
4.4. Start with the rheotactic protocol (section 5). 205 
 206 
5. Test of the zebrafish rheotaxis in the flow chamber  207 
 208 
5.1. Transfer one to five fish to the flow tunnel using a 2 L tank with the sides and the bottom 209 
obscured. 210 
 211 
5.2. Turn on the pump and set the flow rate in the tunnel to 1.7 cm/s. 212 
 213 
NOTE: This slow-moving water will keep the water in the tunnel oxygenated and it will facilitate 214 
animal recovery. 215 
 216 
5.3. Let the animals acclimate to the swimming tunnel for 1 h. 217 

 218 
5.4. Start the video recording of the behavior of the fish in the tunnel. 219 
 220 



  

NOTE: We used a camera (e.g., Yi 4K Action) with remote control (e.g., Bluetooth) and saved the 221 
video as .mpg (30 frames/s). 222 

 223 
5.5. Start the stepwise increase of the flow rate according to the chosen experimental protocol 224 
(1.3 cm/s in this study; Figure 4). 225 
 226 
NOTE: For this protocol, we used low flow rates which, for zebrafish, range from 0 to 2.8 BL (body 227 
lengths)/s. These flow speeds are in the lower range of flow rates that induce continuous 228 
oriented swimming in zebrafish (3%–15% of critical swimming speed [Ucrit])24. The use of low flow 229 
rates (following Brett’s protocol25) is linked to the specific behavioral characteristics of this 230 
species in the presence of water currents. Zebrafish tend to swim along the major axis of the 231 
chamber, turning frequently, even in the presence of water flow, and tend to swim both 232 
upstream and downstream24,26. This behavior is affected by the water flow rate, disappearing at 233 
relatively high speeds (>8 BL/s)26, when the animals continuously swim facing upstream (full 234 
positive rheotactic response). Vertical and transversal displacements are very rare. 235 
 236 
5.6. Perform morphometry of the animals (sex and total length [TL], fork length [FL], or BL) on 237 
screenshots from the video recordings of the fish in the swimming tunnel. 238 
 239 
5.6.1. Select the appropriate screenshot. 240 
 241 
5.6.2. Open the screenshot in ImageJ. 242 
 243 
5.6.3. Take note of the sex of the animal (male zebrafish are slender and tend to be yellowish, 244 
while females are more rounded and tend to have blue and white colorings). 245 
 246 
5.6.4. Click Analyze > Set Scale and set the scale of the image in centimeters, using the whole 247 
horizontal length of the tunnel as reference.  248 
 249 
5.6.5. Click Analyze > Measure and record the linear length of the animal.  250 
 251 
5.6.6. Calculate its body weight (BW). 252 
 253 
NOTE: BW is calculated from sex-FL-BW relationships previously built in the lab or from metadata. 254 
The whole procedure avoids manipulation stress on the animals. 255 

 256 
6. Video tracking  257 

 258 
6.1. Open the video file with Tracker 4.84 Video Analysis and Modeling Tool. 259 
 260 
NOTE: If necessary, correct any video distortion using perspective and radial distortion filters.  261 
 262 
6.2. Click on Coordinate system in the upper menu and set the length units to centimeters and 263 
the time units to seconds. 264 



  

 265 
6.3. Click on File > Import > Video and open one of the videos in Tracker 4.84.  266 

 267 
6.4. Click on Coordinate axes and set the reference system to track the position of the fish over 268 
time with the x-axis along the tunnel. Set the origin at the low corner of the wall upstream (at 269 
the water inlet). 270 

 271 
6.5. Click on Track > New > Point of mass and start tracking one fish at a time. Track the last 5 272 
min of each step that the fish spent at each flow rate.  273 
 274 
6.6. Advance the video manually at five-frame intervals (0.5 s) and mark the time and position of 275 
the animal at each upstream-downstream turn (UDt; red dots in Figure 5) and at each 276 
downstream-upstream turn (DUt; blue dots in Figure 5). 277 
 278 
NOTE: Use the fish eye position as a reference for the fish’s position. Track the animal’s position 279 
using a Point mass. Exclude from the tracking any period of non-oriented swimming (i.e., 280 
maneuvering time). 281 

 282 
6.7. At the end of each tracking session, select the x-values and time values from the table at the 283 
bottom-right corner of the software window. Right-click on the data and click Copy data > Full 284 
precision.  285 
 286 
6.8. Save the time values and x-values of all turning positions on a template spreadsheet file to 287 
calculate the total upstream time (sum of all the intervals between UDts and DUts) and the total 288 
downstream time (sum of the intervals between DUts and UDt), as well as the values of the 289 
rheotactic index in percentages (RI%) for each flow step (see Figure 5). 290 
 291 
NOTE: The rheotactic behavior is quantified by the proportion of the total oriented time that the 292 
fish spend facing upstream (swimming or rarely freezing [i.e., they stay still at the bottom of the 293 
tunnel]27). This proportion is defined as the RI% (Figure 5). 294 

 295 

𝑅𝐼 (%) =
𝑢𝑝𝑠𝑡𝑟𝑒𝑎𝑚 𝑡𝑖𝑚𝑒

(𝑢𝑝𝑠𝑡𝑟𝑒𝑎𝑚 𝑡𝑖𝑚𝑒 + 𝑑𝑜𝑤𝑛𝑠𝑡𝑟𝑒𝑎𝑚 𝑡𝑖𝑚𝑒)
× 100 296 

 297 
REPRESENTATIVE RESULTS: 298 
As sample data we present results obtained controlling the magnetic field along the water flow 299 
direction on proactive and reactive shoaling zebrafish16 using the setup shown in Figure 2A (see 300 
section 3 of the protocol). These results show how the described protocol can highlight 301 
differences in responses to the magnetic field in fish with different personalities. The overall 302 
concept of these trials relies on the finding that the direction of the magnetic field relative to the 303 
water flow affects the rheotactic threshold in shoaling zebrafish14. Thus, as changes in the 304 
magnetic field modulate the rheotaxis, this protocol can be used to assess if the response of 305 
zebrafish to magnetic fields differ according to their proactive or reactive personality28.  306 



  

 307 
At first, using the dark/bright tank as shown in Figure 3, zebrafish were split into different groups 308 
according to their proactive/reactive personality. Following such a test, shoals of five fish with 309 
the same personality were then tested in the solenoid swimming tunnel (Figure 1 and Figure 2A). 310 
A total of 20 fish were tested: two shoals composed of five reactive fish each (10 reactive fish) 311 
and two shoals composed of five proactive fish each (10 proactive fish).  312 
 313 
One shoal at a time was video recorded while swimming in the tunnel and the water current was 314 
accelerated with a stepwise increase of the flow rate as schematically shown in Figure 4. The fish 315 
were allowed to acclimate for 1 h in the tunnel. After that, we applied the protocol for the 316 
quantification of the rheotactic behavior, using a stepwise increase of the flow rate according to 317 
the classic Brett protocol25. Specifically, the flow rate increased by 0.4 BL/s every 10 min for a 318 
total of seven consecutive steps (Figure 4). The behavior of the zebrafish was recorded 319 
throughout the whole duration of the run in the tunnel (70 min), and the RI value at each step 320 
was calculated (see protocol step 6.8). 321 
 322 
During the runs in the swimming tunnel, the magnetic field was set at one of the two following 323 
conditions: 50 μT downstream (i.e., the horizontal component [along the x-axis] of the magnetic 324 
field had the same direction of water flow) and 50 μT upstream (i.e., the horizontal component 325 
of the magnetic field had an opposite direction with respect to the water flow)16. The intensity 326 
along axes y and z were not affected, as well as the total intensity and inclination of the magnetic 327 
field vector. Each shoal of five fish was exposed to only one of the two magnetic conditions. For 328 
example, considering proactive fish, one proactive shoal had the magnetic field directed 329 
downstream and the other proactive shoal had the magnetic field directed upstream. 330 
 331 
The videos were then analyzed with the video-tracking software (section 6 of the protocol). The 332 
fish were video recorded for the whole duration of the run in the swimming tunnel. However, 333 
only the last 5 min of each 10 min-long stepwise increase of flow rate (Figure 4) were tracked. 334 
During the tracked time, the turns of each fish at each flow rate were highlighted (Figure 5, red 335 
and blue data points). These were then used as references to calculate the RI of each fish and 336 
each flow speed (Figure 5). The RI index ranges between 0% and 100%. When below 50%, the RI 337 
index indicates that the fish displayed negative rheotaxis (prevalence of downstream swimming); 338 
when the RI is higher than 50%, it shows that the animal had a positive rheotactic response 339 
(prevalence of upstream swimming). An RI not significantly different from 50% would indicate an 340 
absence of rheotactic response. The values of RI% of all the five fish in a shoal were then averaged 341 
at each flow rate. These averaged data were arcsine transformed and used to fit the curves 342 
displayed in Figure 6A. Thus, the rheotactic index increases sigmoidally when the water speed 343 
increases, allowing the quantification of the rheotaxis with a simple mathematical method. The 344 
relationship between the RI and the flow rate can be fitted to the following logistic-sigmoidal 345 
model. 346 
 347 

𝑅𝐼 = 𝑅𝐼𝑏𝑜𝑡𝑡𝑜𝑚 +
(𝑅𝐼𝑝𝑙𝑎𝑡𝑒𝑎𝑢 − 𝑅𝐼𝑏𝑜𝑡𝑡𝑜𝑚)

(1 + 10(𝑅𝑡𝑟−𝑓𝑙𝑜𝑤 𝑟𝑎𝑡𝑒))
 348 

 349 



  

Three parameters and their variability can be derived from the fit curve. The RIplateau measures 350 
the maximal tendency of the animals to orient upstream in the range of flow rates used in the 351 
experiment. RIbottom is the RI value in the absence of water flow and, hypothetically, should not 352 
differ from 50%. Rtr is the is the flow rate at which the maximum slope of the curve occurs, and 353 
it can be used as a measure of the rheotactic threshold6. 354 
 355 
The results indicate that the rheotactic threshold (Rtr) of zebrafish is very low, in the range of a 356 
few centimeters per second. Variations of the magnetic field do not affect the Rtr of proactive 357 
fish (no effect of the magnetic field, t-test, P > 0.05). Oppositely, magnetic field changes have a 358 
pronounced effect on the rheotactic behavior of reactive zebrafish. When the magnetic field 359 
component along the swimming tunnel was directed downstream, the Rtr is very low and similar 360 
to that of proactive fish. The threshold was significantly higher when the magnetic field was 361 
directed upstream (t-test, P < 0.01).  362 
 363 
The RIplateau value of reactive animals was significantly lower when the magnetic field was directed 364 
upstream (t-test, P < 0.01). This result indicates that with these conditions, reactive fish would 365 
reach the full positive rheotactic response (RI = 100%) only at very high flow rates. Thus, this 366 
result highlights that, compared to Rtr, RIplateau provides less information about the swimming 367 
behavior of the fish. In fact, based on the strong difference in the reactive RIplateau between the 368 
two magnetic conditions, we can state that, under the upstream-oriented magnetic field, the 369 
reactive animals will probably display a full rheotactic response at a higher water flow. 370 
 371 
RIbottom values tend to be higher (although not significantly) than 50% in the proactive animals 372 
and in the reactive animals exposed to a downstream-oriented magnetic field. This may indicate 373 
a bias in the protocol since the animals characterized by a very low threshold may remember the 374 
flow direction experienced during acclimation. A proper protocol could be devised to test this 375 
possibility. 376 
 377 
FIGURE AND TABLE LEGENDS: 378 
 379 
Figure 1: Simplified representation of the swimming tunnel apparatus utilized in the present 380 
study.  381 
 382 
Figure 2: Setup for magnetic field control. (A) Rendering of the swimming tunnel with a solenoid 383 
for the induction of a static, horizontal magnetic field within the tunnel. The solenoid (0.83 384 
turns/cm) is connected to a power unit and it generates fields in the range of ±250 µT (intensity 385 
range that includes the earth’s magnetic field range). On the right-hand side, a photo of the 386 
solenoid tunnel connected to the swimming apparatus is shown. The tunnel is made of acrylic 387 
and it has two perforated acrylic plates placed at the water inlet, which guarantee the flow to be 388 
close to laminar. (B) Diagram and photo of the three orthogonal Helmholtz pairs set for the 389 
control of the magnetic field in the geomagnetic range of intensities. The magnetic field probe, 390 
the CPU, the digital-to-analog converter, and the coil drivers used to close the loop are also 391 
shown. Each pair of coils is composed of two circular coils with a radius (r) of 30 cm and N = 50 392 
turns of AWG-14 copper wires. A three-axes magnetometer (sensor) with selectable scale (± 88 393 



  

µT to ± 810 µT) is placed close to the center of the coil set. The sensor range is set to values 394 
ranging to ±130 µT. These values were also used for the measurements described in the 395 
representative results (in these conditions, the nominal sensor resolution is about 0.1 µT). The 396 
intensity and the direction of the magnetic field are controlled with a digital feedback system. 397 
The sensor measures the three components of the magnetic field vector (the three axes), and 398 
the corresponding error signals are extracted. Then, the correction signals are generated by a 399 
simple integrator filter. The digital correction signals are converted to voltage by a digital-to-400 
analog converter and amplified by a suitable coil driver. These last signals are used to drive the 401 
Helmholtz pairs. The sampling frequency is fixed to 5 Hz and the unity gain frequency of the loops 402 
is about 0.16 Hz. Once the currents in the Helmholtz pairs of the coils are set, the total magnetic 403 
field varies less than 2% from its mean intensity value in the central cubic volume (with edge [L] 404 
= 10 cm) of the coils. During the measurements, the magnetic field rms is less than 0.2 µT. In both 405 
the setups (panels A and B) a static electric field is generated by the current in the coils producing 406 
the magnetic field16. The intensity of the electric field is about 0.4 V/m when the maximum 407 
current is applied; this value is negligible compared to natural or artificial static fields present in 408 
the environment whose intensity is of the order of 1 kV/m17. 409 
 410 
Figure 3: Schematic representation of the tank (40 cm x 40 cm x 40 cm) used to separate 411 
proactive from reactive zebrafish individuals (not in scale), according to Rey et al.21. The volume 412 
of the personality selection tank is 50 L. Half of the tank was occupied by a dark box with a hole 413 
of 5 cm in diameter on the side of the box facing the bright half of the tank. The hole was covered 414 
by a sliding door (not shown), whose opening signed the start of a selecting trial. The dark side 415 
of the tank needs a removable cover to allow access of hand nets. This facilitates placing or 416 
catching fish before and after the behavioral trials. 417 
 418 
Figure 4: Diagram of the flow rates used during the tests to determine the rheotactic threshold 419 
of zebrafish. The flow during the 1 h acclimation period was enough to guarantee an adequate 420 
oxygen supply to the animals. It can be assumed that, with this design, oxygen supply is never a 421 
limit, even in the first 10 min step with flow 0. Indeed, with an oxygen content of water at 27 °C 422 
of about 7.9 mg/L and an animal oxygen consumption of 1 mg/h.g (an excess approximation for 423 
zebrafish oxygen consumption both under routine conditions [Uliano et al.29] and at low-speed 424 
swimming [Palstra et al.30]), it is possible to calculate that, in the absence of flow, the Po2 in the 425 
flume will not decrease more than 2% per animal, remaining well above the critical Po2 (about 426 
40 torr for zebrafish). This figure has been modified from Cresci et al.14. 427 
 428 
Figure 5: Animal behavior in the tunnel and the calculation of RI. The graphs present the 429 
position of an individual animal along the x-axis during a 300 s record at three values of flow rate. 430 
The red dots represent the downstream-to-upstream turns, the blue dots the upstream-to-431 
downstream turns. The corresponding time intervals spent by the animals downstream or 432 
upstream are also reported, and the total upstream and downstream times are reported, from 433 
which an RI value can be calculated. It can be observed that when increasing the flow rate, the 434 
upstream time and the RI values increase. 435 
 436 
Figure 6: Representative results. (A) Relationship between arcsine-transformed RI values (RI is 437 



  

the percentage of the total oriented time that fish spend facing upstream) and the flow rate for 438 
proactive and reactive shoaling zebrafish under two magnetic field conditions along the flow rate 439 
direction (one-dimension control). Each data point is the average of the RI values of the five fish 440 
composing the shoal, at each flow rate. Significant differences between curves were tested via a 441 
sum-of-squares F-test (alpha = 0.05)14. (B) Magnetic field axes and direction of the water flow in 442 
the tunnel. A three-dimensional representation of the magnetic vectors in the two magnetic field 443 
conditions used in this study is also shown. The magnetic field in the lab (40°N, 14°E) was: F = 62 444 
μT; I = 64°; D = 44°. This figure has been modified from Cresci et al.16.  445 
 446 
DISCUSSION: 447 
The protocol described in this study allows scientists to quantify complex orientation responses 448 
of aquatic species resulting from the integration between two external cues (water current and 449 
geomagnetic field) and one internal factor of the animal, such as personality. The overall concept 450 
is to create an experimental design that allows scientists to separate individuals of different 451 
personality and investigate their orientation behavior while controlling separately or 452 
simultaneously the external environmental cues.  453 
 454 
The protocol described in this study, together with the mathematical definition of the rheotactic 455 
index (RI), was designed following preliminary observations of the behavior of zebrafish in the 456 
swimming tunnel. When placed in a tunnel, these animals display two types of behavioral 457 
patterns, both in the absence or presence of water flow: oriented swimming and maneuvering. 458 
They spend the majority of the oriented time (usually, the fish were video recorded for more 459 
than 95% of the time) swimming along the tunnel (i.e., oriented along the long axis with an angle 460 
lower than 45°), back and forth, turning in proximity of the end walls and often showing 461 
thigmotaxis (i.e., swimming close to the walls of the tunnel)27.  462 
 463 
For this protocol to be successful, it is important that whoever performs the experiment pays 464 
attention to the stress of the animals. The transportation of the fish between the experimental 465 
setups must be executed with care. The usage of hand nets should be as quick as possible, and 466 
some training before the actual experiment is highly recommended as zebrafish are fast 467 
swimmers and hard to catch in a tank. Stress can dramatically affect the behavior of these 468 
animals, and in the case of zebrafish, it can significantly change their swimming behavior27. This 469 
would probably affect the results, as fish might display hyperactive behavior and be less sensitive 470 
to water flows and magnetic field changes. Contact with the animals in the experimental setup 471 
should be as quick and short as possible. The behavioral analysis requires remote observation, 472 
which also requires practice. Moreover, it is important to analyze the videos blindly (i.e., without 473 
knowing protocols and treatments). 474 
 475 
The rheotactic behavior of many species of fish has been studied using swimming tunnels5,10,11,31. 476 
Numerous previous studies focused on the estimation of the swimming speed that fish can 477 
sustain until exhaustion, which is defined as Ucrit, mostly to test physiological and ecological 478 
hypotheses11,32,33. The method described in this study focuses, instead, on the rheotactic 479 
behavior at low flow speeds. This choice was made because the objective of this study is to assess 480 
the sensitivity to a subtle and weak cue like the magnetic field through the observation of a well-481 



  

known and robust orientation behavior of fish, the positive rheotaxis. In the representative 482 
results reported here, zebrafish displayed a very low rheotactic threshold (only a few centimeters 483 
per second). This observation could be ecologically relevant for this species, which inhabits 484 
environments where the speed of water currents can significantly vary. Zebrafish live both in 485 
turbulent rivers34 and in water bodies where the water moves slowly, such as paddies, ponds, 486 
and floodplains35. When water moves slowly, the ability to detect and orient at low flow speeds 487 
(a low rheotactic threshold) could possibly be advantageous, as the rheotactic response increases 488 
the chances to intercept downstream-drifting prey36 and provides directional stimuli for 489 
migration37. 490 
 491 
These observations could not be made using flows with high rates. These would elicit a strong 492 
locomotory response that would depend more on the body conditions and high swimming 493 
performances of the animals rather than external cues like the magnetic field. The protocol 494 
presented here was applied on zebrafish, but it is likely suitable for any freshwater or marine 495 
species that inhabit environments with moving water and can be handled in laboratory 496 
conditions. 497 
 498 
However, this protocol presents some limitations. While it clearly highlights whether a species is 499 
sensitive or nonsensitive to magnetic fields, it cannot reveal the orientation mechanisms through 500 
which the animal uses magnetic fields for movement decisions. In order to investigate the 501 
magnetic orientation mechanisms in aquatic species, setups with circular arenas and still 502 
water7,38,39 or mazes13 are commonly used. However, fish (and aquatic animals in general) do not 503 
live in environments where currents are absent, and the presented method is a first attempt to 504 
investigate the integrative behavioral response to ubiquitous directional cues, like water flows 505 
and magnetic fields. Another limitation of this protocol is the manual video-tracking procedure. 506 
Integrating this setup with an automatic tracking software would improve the timing of the whole 507 
data analysis process. 508 
 509 
The experimental protocol presented here is the first one designed to investigate the influence 510 
of animal personality on magnetic sensitivity and rheotaxis. This topic has been overlooked in the 511 
literature and needs to be further explored. Individuals from the same species, or even within a 512 
population or small group (such as a fish shoal), are characterized by different personality 513 
traits22,40, which can be an important factor in studies on migratory, exploratory, navigation, and 514 
orientation behavior. Not all the individuals integrate the environmental cues in the same way. 515 
Thus, taking into account internal factors, such as personality, could help to reduce the data 516 
variability which is commonly observed in studies on movement ecology16. 517 
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and (c) to license others to do any or all of the above. The 
foregoing rights may be exercised in all media and formats, 
whether now known or hereafter devised, and include the 
right to make such modifications as are technically 
necessary to exercise the rights in other media and formats. 
For any Video to which this Section 6 is applicable, JoVE and 
the Author hereby grant to the public all such rights in the 
Video as provided in, but subject to all limitations and 
requirements set forth in, the CRC License. 
7. Government Employees. If the Author is a United 
States government employee and the Article was prepared 
in the course of his or her duties as a United States 
government employee, as indicated in Item 2 above, and 
any of the licenses or grants granted by the Author 
hereunder exceed the scope of the 17 U.S.C. 403, then the 
rights granted hereunder shall be limited to the maximum 

rights permitted under such statute. In such case, all 
provisions contained herein that are not in conflict with 
such statute shall remain in full force and effect, and all 
provisions contained herein that do so conflict shall be 
deemed to be amended so as to provide to JoVE the 
maximum rights permissible within such statute. 
8. Protection of the Work. The Author(s) authorize 
JoVE to take steps in the Author(s) name and on their behalf 
if JoVE believes some third party could be infringing or 
might infringe the copyright of either the Author’s Article 
and/or Video. 
9. Likeness, Privacy, Personality. The Author hereby 
grants JoVE the right to use the Author’s name, voice, 
likeness, picture, photograph, image, biography and 
performance in any way, commercial or otherwise, in 
connection with the Materials and the sale, promotion and 
distribution thereof. The Author hereby waives any and all 
rights he or she may have, relating to his or her appearance 
in the Video or otherwise relating to the Materials, under 
all applicable privacy, likeness, personality or similar laws. 
10. Author Warranties. The Author represents and 
warrants that the Article is original, that it has not been 
published, that the copyright interest is owned by the 
Author (or, if more than one author is listed at the beginning 
of this Agreement, by such authors collectively) and has not 
been assigned, licensed, or otherwise transferred to any 
other party. The Author represents and warrants that the 
author(s) listed at the top of this Agreement are the only 
authors of the Materials. If more than one author is listed 
at the top of this Agreement and if any such author has not 
entered into a separate Article and Video License 
Agreement with JoVE relating to the Materials, the Author 
represents and warrants that the Author has been 
authorized by each of the other such authors to execute this 
Agreement on his or her behalf and to bind him or her with 
respect to the terms of this Agreement as if each of them 
had been a party hereto as an Author. The Author warrants 
that the use, reproduction, distribution, public or private 
performance or display, and/or modification of all or any 
portion of the Materials does not and will not violate, 
infringe and/or misappropriate the patent, trademark, 
intellectual property or other rights of any third party. The 
Author represents and warrants that it has and will 
continue to comply with all government, institutional and 
other regulations, including, without limitation all 
institutional, laboratory, hospital, ethical, human and 
animal treatment, privacy, and all other rules, regulations, 
laws, procedures or guidelines, applicable to the Materials, 
and that all research involving human and animal subjects 
has been approved by the Author's relevant institutional 
review board. 
11. JoVE Discretion. If the Author requests the 
assistance of JoVE in producing the Video in the Author’s 
facility, the Author shall ensure that the presence of JoVE 
employees, agents or independent contractors is in 
accordance with the relevant regulations of the Author's 
institution. If more than one author is listed at the 
beginning of this Agreement, JoVE may, in its sole 



ARTICLE AND VIDEO LICENSE AGREEMENT 
 

612542.6 For questions, please contact us at submissions@jove.com or +1.617.945.9051. 

discretion, elect not take any action with respect to the 
Article until such time as it has received complete, executed 
Article and Video License Agreements from each such 
author. JoVE reserves the right, in its absolute and sole 
discretion and without giving any reason therefore, to 
accept or decline any work submitted to JoVE. JoVE and its 
employees, agents and independent contractors shall have 
full, unfettered access to the facilities of the Author or of 
the Author’s institution as necessary to make the Video, 
whether actually published or not. JoVE has sole discretion 
as to the method of making and publishing the Materials, 
including, without limitation, to all decisions regarding 
editing, lighting, filming, timing of publication, if any, 
length, quality, content and the like.  
12. Indemnification. The Author agrees to indemnify 
JoVE and/or its successors and assigns from and against any 
and all claims, costs, and expenses, including attorney’s 
fees, arising out of any breach of any warranty or other 
representations contained herein. The Author further 
agrees to indemnify and hold harmless JoVE from and 
against any and all claims, costs, and expenses, including 
attorney’s fees, resulting from the breach by the Author of 
any representation or warranty contained herein or from 
allegations or instances of violation of intellectual property 
rights, damage to the Author’s or the Author’s institution’s 
facilities, fraud, libel, defamation, research, equipment, 
experiments, property damage, personal injury, violations 
of institutional, laboratory, hospital, ethical, human and 
animal treatment, privacy or other rules, regulations, laws, 
procedures or guidelines, liabilities and other losses or 
damages related in any way to the submission of work to 
JoVE, making of videos by JoVE, or publication in JoVE or 
elsewhere by JoVE. The Author shall be responsible for, and 
shall hold JoVE harmless from, damages caused by lack of 
sterilization, lack of cleanliness or by contamination due to 

the making of a video by JoVE its employees, agents or 
independent contractors. All sterilization, cleanliness or 
decontamination procedures shall be solely the 
responsibility of the Author and shall be undertaken at the 
Author’s expense. All indemnifications provided herein 
shall include JoVE’s attorney’s fees and costs related to said 
losses or damages. Such indemnification and holding 
harmless shall include such losses or damages incurred by, 
or in connection with, acts or omissions of JoVE, its 
employees, agents or independent contractors. 
13. Fees. To cover the cost incurred for publication, 
JoVE must receive payment before production and 
publication of the Materials. Payment is due in 21 days of 
invoice. Should the Materials not be published due to an 
editorial or production decision, these funds will be 
returned to the Author. Withdrawal by the Author of any 
submitted Materials after final peer review approval will 
result in a US$1,200 fee to cover pre-production expenses 
incurred by JoVE. If payment is not received by the 
completion of filming, production and publication of the 
Materials will be suspended until payment is received. 
14. Transfer, Governing Law. This Agreement may be 
assigned by JoVE and shall inure to the benefits of any of 
JoVE’s successors and assignees. This Agreement shall be 
governed and construed by the internal laws of the 
Commonwealth of Massachusetts without giving effect to 
any conflict of law provision thereunder. This Agreement 
may be executed in counterparts, each of which shall be 
deemed an original, but all of which together shall be 
deemed to me one and the same agreement. A signed copy 
of this Agreement delivered by facsimile, e-mail or other 
means of electronic transmission shall be deemed to have 
the same legal effect as delivery of an original signed copy 
of this Agreement.
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Replies to comments 

We thank the editor for the helpful comments. We followed the comments step by step and modified 

the manuscript accordingly, especially the protocol section. We updated the order of the figures, which 

is now different compared to the previous version of the manuscript. 

All the edits in the manuscript are visible as we left the option “Track changes” active in the .docx 

document.  

Please find our replies to the comments in blue. 

Sincerely, 

Alessandro Cresci 

 

Editorial comments: 

1. The editor has formatted the manuscript to match the journal's style, please retain the same. 

We retained the same format as the version of the manuscript provided by the editor. 

2. Please address all the specific comments marked in the manuscript. 

We addressed every comment we found in the manuscript. In case the comments from the editor are no 

longer visible it is because we had to erase that specific part of text. However, all the edits applied to the 

manuscript follow the instructions provided by the comments of the editor. 

3. The Protocol should contain only action items that direct the reader to do something. This can be in 

the form of discrete experimental steps, graphical user interface, the knob turns, button clicks, scripts if 

any, etc. 

The protocol now contains only short action items. All the additional information is provided in the 

introduction, the results or as NOTE. 

4. Please ensure that all text in the protocol section is written in the imperative tense as if telling 

someone how to do your experiment (e.g., “Do this,” “Ensure that,” etc.) with all specific details. The 

actions should be described in the imperative tense in complete sentences wherever possible. 

All the action items are now in imperative form. 

5. The Protocol should be made up almost entirely of discrete steps without large paragraphs of text 

between sections. 

We moved all the text between sections to the introduction, to the results or as a note. 

6. Please ensure you answer the “how” question, i.e., how is the step performed? 

We now answer to “how” in almost every step. 

7. Once done please ensure that the protocol is no more than 10 pages and highlighted step is no more 

than 2.75 pages including headings and spacing. 

The protocol is less than 10 pages and the highlighted text is 2 pages long. 

8. Please format all units as g/ml and not g ml-1. Please change this for the figures as well. 

Rebuttal Letter Click here to access/download;Rebuttal
Letter;replies_editorial_comments.docx

https://www.editorialmanager.com/jove/download.aspx?id=954388&guid=1561af16-1c0f-404f-b300-ed3dcf3293c6&scheme=1
https://www.editorialmanager.com/jove/download.aspx?id=954388&guid=1561af16-1c0f-404f-b300-ed3dcf3293c6&scheme=1


We formatted all units accordingly. 
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7. Rights for additional components such as custom editions and derivatives require 
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8. The Licensor's permission must be acknowledged next to the licensed material in print. In 
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9. Use of the material for incidental promotional use, minor editing privileges (this does not 

include cropping, adapting, omitting material or any other changes that affect the 

meaning, intention or moral rights of the author) and copies for the disabled are 

permitted under this licence. 
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